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Congratulations on the purchase of a new Windows Mobile-based Pocket PC Phone. The 
integrated wireless voice and data capabilities mean that as well as keeping your 
important PIM information up-to-date and close at hand, you can make calls, send and 
receive e-mail, and look up valuable information from the Internet or your company’s 
network anytime, anywhere. Also, with Microsoft® ActiveSync® the power of your 
device is increased by allowing you to synchronize the information on your PC with your 
device.  
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When you first start up your Pocket PC Phone, you will be 
asked to calibrate the screen by tapping the center of a cross 
with your stylus as it moves around the screen. This process 
ensures that when you tap the screen with your stylus the item 
tapped is activated. 

If your device does not accurately respond to screen taps, you 
will need to re-calibrate it. 

To re-calibrate the screen: 

Tap  
z Settings 
z System 
z Screen. 
 As described above, tap the center of the cross to with your 

stylus as it moves around the screen. 
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The Today screen displays important information, such as 
today’s appointments and status icons for your device. Tap the 
information listed on the Today screen to open the associated 
program.  

Access the Today screen by tapping  
z Today. 

To customize the Today screen display, including the back-
ground image, tap Today at the top of the Today screen or tap 

  
z Settings 
z Personal tab 
z Today 
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Indicators Meaning 
 Turns all sounds on and off. 
 Main battery low. 
 Main battery very low. 
 Connection is active. 
 Synchronization is beginning or ending. 
 Synchronization is occurring. 
 Notification that one or more instant messages were received. 

 
Notification that one or more mobile e-mail / SMS messages were 
received. 

 
Indicates the connection to your mobile phone service provider is on and 
the strength of the signal. 

 Indicates your phone is switched off. 

 
If more notification icons need to be displayed and there is no room to 
display them, this indicator will display. Tap the icon to view all 
notification icons. 

Indicators 
Following are some of the status icons you may see. 
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Icon Program Description 
 ActiveSync Synchronizes information between your device and PC. 

 
Calendar Keeps track of your appointments and creates meeting 

requests. 
 Contacts Keeps track of your friends and colleagues. 
 Inbox Sends and receives e-mail/ SMS messages. 

 
Pocket IE Pocket Internet Explorer browses Web and WAP sites, and 

downloads new programs and files from the Internet. 

 
Notes Creates handwritten or typed notes, drawings, and record-

ings. 

 
Phone Makes and receives calls, switches between calls and sets up 

conference calling.  
 Tasks Keeps track of your tasks. 

 
Windows         
Media Player 

Enables the multimedia function on your Pocket PC Phone.  

 Pocket Excel Creates new workbooks or view and edit Excel workbooks. 

 
Pocket Word Creates new documents or view and edit MS-Word docu-

ments.  

 
MSN                   
Messenger 

Sends and receives instant messages with your MSN Mes-
senger contacts. 

 
Microsoft              
Reader 

Collects and reads e-Books on your device. 
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You can switch from one program to another by selecting it from 

the   menu. To access some programs, tap   
z Programs, and 
then the program name. 

The following table contains a partial list of programs that are on 
your device. Look on the Pocket PC Companion CD for additional 
programs that you can install onto your device. 



 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Navigation Bar and Command Bar 
 

The navigation bar, located at the top of the screen, displays 
active programs and current time, enables you to switch to 
programs and close screens.  
 

Use the command bar at the bottom of the screen to 
perform tasks in programs.  
 

The command bar includes menu names, buttons, and the 
Input Panel button. To create a new item in the current 
program, tap New. To see the name of a button, tap and hold 
the stylus on the button. Drag the stylus off the button so 
that the command is not carried out. 
 

Tap to switch to a 
program that you 
recently used 

Tap to switch to a 
program 

Tap to see more 
programs 

Tap to change 
device settings 

Tap to see a help topic 
for the current screen 

select menu 
commands 

Select button 
commands 

Display the 
input panel 

Pop-Up Menus 
 

Use pop-up menus to quickly perform an action on an item. 
For example, you can use a pop-up menu to delete or make 
a copy of an item. To access a pop-up menu, tap and hold 
the item that you want to perform the action on. When the 
menu appears, tap the action you want to perform, or tap 
anywhere outside the menu to close it without performing 
an action. 

Tap and hold to display the pop-up menu. 
Lift the stylus and tap the action you want. 
Tap outside the menu to close it without performing an 

action. 

Notifications 
 

Your device reminds you in a variety of ways when you 
have something to do or receive a SMS. For example, if 
you’ve set up an appointment in Calendar, a task with a due 
date in Tasks, or an alarm in Clock, you will be notified in 
any of the following ways: 

 A message box appears on the screen. 
 A sound, which you can specify, is played. 
 A light flashes on your device.  
 The device vibrates.  

 



 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

To choose reminder types and sounds for your device, tap   


z Settings 
z Personal 
z Sounds & Notifications. The options 
you choose here apply throughout the device. 
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You can enter information on your device in several ways, 
depending on the type of device you have and the program 
you are using. 

 Synchronizing – Using ActiveSync, exchange infor-
mation between your PC and device.  

 Typing -  Using the input panel, enter typed text into 
the device. You can do this by tapping keys on the soft 
keyboard or by using the handwriting recognition soft-
ware.  

 Writing - Using the stylus, write directly on the screen.  
 Drawing - Using the stylus, draw directly on the 

screen.  
 Recording - Create a stand-alone recording or embed a 

recording into a document or note. 
 
For more information on ActiveSync, see Chapter 4 

Using the Input Panel 
 
Use the input panel to enter information in any program on 
your device. You can either type using the soft Keyboard or 
write using Letter Recognizer, Block Recognizer, or 
Transcriber. In either case, the characters appear as typed text 
on the screen.  
To show or hide the input panel, tap the Input Panel 
button  . To see your choices tap the arrow next to the Input 
Panel button. 
 



 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

a. To type with the soft keyboard 
 

 Tap the arrow next to the Input Panel button    and then 
Keyboard. 

 To type lowercase letters, tap the keys with the stylus.  
 To type a single uppercase letter or symbol, tap the Shift 

key. To tap multiple uppercase letters or symbols, tap the 
CAP key.  

 For uppercase, tap and hold the stylus on the a key and 
drag up.  

 To add a space, tap and hold any key and then drag the 
stylus to the right across at least two others.  

 To backspace one character, tap and hold any key and 
then drag the stylus to the left across at least two others.  

 To insert a carriage return, tap and hold the stylus 
anywhere on the keyboard and drag down.  

 
When you use the input panel, your device anticipates the word 
you are typing or writing and displays it above the input panel. 
When you tap the displayed word, it is automatically inserted into 
your text at the insertion point. The more you use your device, the 
more words it learns to anticipate. 

If you want to use larger keys, tap the   arrow next to the Input 

Panel button 
z then tap Options 
z select Keyboard in Input 

method and 
z then select Large Keys. 

b. Using Letter Recognizer 
 

With Letter Recognizer you can write letters using the stylus just 
as you would on paper. 

1. Tap the arrow next to the Input Panel button   and then 
Letter Recognizer. 

2. Write a letter in the box. 
 
When you write a letter, it is converted to typed text that appears 
on the screen. For specific instructions on using Letter 
Recognizer, with Letter Recognizer open, tap the question mark 

  next to the writing area. 
 



 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

c. Using Block Recognizer 
 

With Block Recognizer you can input character strokes using the 
stylus that are similar to those used on other devices. 

1. Tap the arrow next to the Input Panel button   and then 
Block Recognizer. 

2. Write a letter in the box. 
 
When you write a letter, it is converted to typed text that appears 
on the screen. For specific instructions on using Block 
Recognizer, with Block Recognizer open, tap the question mark 

  next to the writing area 

d. Switching to Transcriber 
 

With Transcriber you can write anywhere on the screen using the 
stylus just as you would on paper. Unlike Letter Recognizer and 
Block Recognizer, you can write a sentence or more of 
information. Then, pause and let Transcriber change the written 
characters to typed characters. 

1. Tap the arrow next to the Input Panel button   and then 
Transcriber. 

2. Write anywhere on the screen. 
 
For specific instructions on using Transcriber, with Transcriber 
open, tap the question mark in the lower right hand corner of the 
screen. 
 

e. To punctuate in Transcriber: 
 

1. Tap the keyboard button   on the toolbar. 
2. Tap the desired punctuation. 
3. Tap OK to hide the keyboard. 

 



 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

f. To learn about writing in Transcriber: 
 

1. Tap button   on the toolbar. 
2. In the screen that appears, select the letter you want to 

learn about, and then tap on one of the examples given 
above. 

For specific instructions on using Transcriber, with Transcriber 
open, tap the question mark   in the right hand corner of the 
tool bar 

g. To select typed text: 
 

If you want to edit or format typed text, you must select it first.  
Drag the stylus across the text you want to select. You 
can cut, copy, and paste text by tapping and holding the 
selected words and then tapping an editing command on 
the pop up menu, or by tapping the command on the 
Edit menu. 

To change word suggestion options, such as the number of 
words suggested at one time,  

Tap   
z Setting 
z Personal tab 
z Input 
z Word Completion 
tab 

h. Editing text 
 

Each input program provides curser keys to move through text 
and backspace so that you can correct spelling, grammar or 
insert additional information.  Alternatively, you can use your 
stylus to make an insert. 
 
After you have made an insert, you can use any of the input 
methods described above to add additional text at the insertion 
point 
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In any program that accepts writing, such as the Notes program, 
and in the Notes tab in Calendar, Contacts, and Tasks, you can 
use your stylus to write directly on the screen. Write the way 
you do on paper. You can edit and format what you have 
written and convert the information to text at a later time. 
 

To write on the screen: 
 

Tap the pen button   to switch to writing mode. This action 
displays lines on the screen to help you write. 
 
Some programs that accept writing may not have the pen 
button. See the documentation for that program to find out how 
to switch to writing mode. 

To select writing: 
 

If you want to edit or format writing, you must select it first. 
 

1. Tap and hold the stylus next to the text you want to 
select until the insertion point appears. 

2. Without lifting, drag the stylus across the text you want 
to select. 

 
If you accidentally write on the screen, tap Tools, then Undo 
and try again. You can also select text by tapping the Pen button 
to deselect it and then drag the stylus across the screen. 
 
You can cut, copy, and paste written text in the same way you 
work with typed text: tap and hold the selected words and then 
tap an editing command on the pop up menu, or tap the 
command on the Edit menu. 

Tap the Pen button and use 
you stylus like a pen 

Tap the Pen button again to 
select the writing you want 



 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Converting writing to text 
 

1. Tap Tools and then Recognize. 
2. If you want to convert only certain words, select them 

before tapping Recognize on the Tools menu (or tap and 
hold the selected words and then tap Recognize on the 
pop up menu). If a word is not recognized, it will be left 
as writing. 

 
If the conversion is incorrect, you can select different words 
from a list of alternates or return to the original writing.  
 

Tap and hold the incorrect word (tap one word at a 
time). On the pop up menu, tap Alternates. A menu with 
a list of alternate words appears. Tap the word you want 
to use, or tap the writing at the top of the menu to return 
to the original writing. 

 

1. Write neatly. 
2. Write on the lines and draw descanters below the line. 

Write the cross of the “t” and apostrophes below the top 
line so that they are not confused with the word above. 
Write periods and commas above the bottom line. 

3. For better recognition, use the Tools menu to increase 
the zoom to 300%. 

4. Write the letters of a word closely and leave big gaps 
between words so that the device can easily tell where 
words begin and end. 

5. Hyphenated words, foreign words that use special 
characters such as accents, and some punctuation cannot 
be converted. 

 
If you edit or add to a word after attempting to recognize it, the 
new writing will not be included if you attempt to recognized it 
again 

To get good recognition: 
 

The writing is turned into text 

Tap the word you want to use 

Tap to return to your original 
writing 
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You can draw on the screen in the same way that you write on 
the screen. The difference between writing and drawing on the 
screen is how you select items and how they can be edited. For 
example, selected drawings can be re-sized, while writing 
cannot. 
 

To create a drawing: 
 

Cross three ruled lines on your first stroke. A drawing box 
appears. Subsequent strokes in or touching the drawing box 
become part of the drawing.  Drawings that do not cross three 
ruled lines will be treated as writing. 
 

The drawing box indicates the 
boundaries of the drawing 

To select a drawing: 
 

If you want to edit or format a drawing, you must select it first. 
 

1. Tap and hold the stylus on the drawing until the 
selection handle appears. To select multiple drawings, 
deselect the pen button and then drag to select the 
drawings you want. 

2. You can cut, copy, and paste selected drawings by 
tapping and holding the selected drawing and then 
tapping an editing command on the pop up menu, or by 
tapping the command on the Edit menu. To re-size a 
drawing, make sure the Pen button is not selected, and 
drag a selection handle. 

 

To change the zoom level so it is easier to work or view your 
drawing, tap Tools and then select a zoom level. 
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In any program where you can write or draw on the screen, you 
can also quickly capture thoughts, reminders, and phone 
numbers by recording a message. In Calendar, Tasks, and 
Contacts, you can include a recording in the Notes tab. In the 
Notes program, you can either create a stand-alone recording or 
include a recording in a written note. If you want to include the 
recording in a note, open the note first. In the Inbox program, 
you can add a recording to an e-mail message. 

To create a recording 
 

1. Hold your device’s microphone near your mouth or 
other source of sound. 

2. Tap   
z Notes 
z  
3. To start recording, tap  . A beep will sound. 
4. To stop recording, tap  . Two beeps will sound. The 

new recording appears in the note list or as an embedded 
icon. 

 

You can also make a recording by pressing the Record button 
on your device. 
 

The Find feature on your device helps you quickly locate 
information. 

1. On the   
z tap Find.  
2. In Find, enter the file name, word, or other information 

you want to search for. If you have looked for this item 
before, tap the Find arrow and select the item from the 
list. 

3. To help narrow your search select a data type under 
Type. 

4. Tap Go. The My Documents folder and sub-folders are 
searched.  

5. In the Results list, tap the item you want to open. 

To quickly find information that is taking up storage space on 
your device, select Larger than 64 KB in Type 
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Like a standard mobile phone you can use your Pocket PC to keep 
track of calls and send SMS messages. You can also take notes 
while talking, dial directly from Microsoft Contacts and easily 
transfer contacts between your SIM card and the RAM of your 
device. 
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The Subscriber Identification Module (SIM) card, also referred to 
as a smart card, fits into your device. It can contain: 
�  

 Mobile phone service provider account details. 
 Information regarding service access and preferences. 
 Contact information, which can be moved to Contacts on 

your device. 
 Any additional services to which you may have a sub-

scription. 
 
For more information regarding SIM cards, see your mobile 
phone service provider’s documentation. 

To install a SIM cards: 
 

1. Turn over your device and press the fixing lock button to 
remove the battery. 

2. Insert the SIM card. Push it forward. 
3. Replace the battery. 

About The Dialer Screen 
 

To access the Dialer Screen, tap  , then Phone, or press  on 
your device. From this screen, you can access Call Log, Speed 
Dial and Phone Setting. 
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Indicator  Meaning 

 Phone off or out of network service.  Tap this icon to turn on the phone 

 In network service, tap this icon to turn off the phone. 

 Call Missed. Tap this icon to view the call(s) you missed. 

 Unread E-mail or SMS. Tap the icon to view unread SMS or E-mail. 

 
Connecting in progress. The icon will disappear when you are connected to 
your ISP. 

 Indicates your connection is at full strength. 
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The icon indicate the strength of the signal 

Last number details are displayed here 

Keypad for inputting 

Ask bar to access phone setting 

View all history including received, 
dialed and missed calls 

Stores numbers you call often 

Make a call 

Indicators 
 

Below are some of the status icons you may see. 

Entering Your PIN 
 

Most SIM cards are preset with a PIN  ( Personal Identification 
Number), provided by your mobile service provider, which you 
need to enter whenever you use your device.  

1. Enter the preset PIN assigned to you by your mobile 
phone service provider (please contact your mobile 
service provider).  

2. Tap    button. 

If your PIN is entered incorrectly three times, the SIM card will 
be blocked. If this happens, you can unblock it with the PIN 
Unblocking Key from your mobile phone service provider. 
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The default settings for your device are programmed to as-
sume that you want to use your phone. Provided you have 
inserted a SIM card, your device will automatically connect 
your mobile phone to your service provider’s network.  
 
The icon   indicates that you are connected to your service 
provider's network. A full strength signal is indicated by  . 
As the strength of the signal diminishes so will the number of 
vertical bars in the icon, with no bars indicating no signal. 

IN MANY COUNTRIES YOU ARE REQUIRED BY LAW 
TO TURN OFF YOUR PHONE WHEN YOU FLY. 
TURNING OFF YOUR POCKET PC DOESN'T TURN OFF 
YOUR PHONE; YOU MUST TURN OFF YOUR 
WIRELESS CONNECTION TO YOUR OPERATOR’S 
NETWORK. 
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You can turn your phone on and off while keeping your actual 
device turned on. 
 

1. While using any program on your device, tap    in 
the title bar at the top of the phone’s display.  

2. Tap Turn on or Turn off option in the pop-up menu. 
3. To receive calls when your device is turned off, leave 

the Phone turned on. 

You can use other programs on your device during a call. To 

quickly switch back to Phone, tap   , or tap   
z Phone 
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1. During a call, tap    or press the volume on  the side 
of your device.  

2. You can select to adjust the phone volume   (ring) 
or device volume    (notification levels and MP3) on 
the pop-up menu. 

 
 
 

3. If you select Vibrate mode,   will appear in the title 
bar at the top of the phone display. 

 
 
 
 
 
 
 

4. Turn off the volume by choosing the Off option. 
 

To adjust the conversation phone volume, you must do it 
during a call. Adjusting the volume at another time will affect 
the ring, notification and MP3 levels. 

With your Pocket PC Phone, you can make a call from the 
Dialer, Contacts, Speed Dial and Call History. 
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The most direct method is by using the Phone keypad. 
 
Tap the number on the keypad then tap  or press   
button. 
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Back Spacing and Deleting 
 

 If you tap a wrong number, you can back space to 
erase individual numbers one at a time.  

 
 

 You can also delete all the numbers in the window by 
tapping Edit and then Clear. 
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Select a contact in the contacts list and then press left or right 
on the navigation pad – the number on the screen will change 
and then press  twice – once to send to the dialer screen and 
once to call. 
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Create speed dials to call frequently-used numbers with a 
single tap. Before you can create a speed dial entry for a 
phone number, that number must already exist in Contacts. 
 

1. From the Phone keypad, tap   
z New. 
2. Tap the desired contact name and number. 
3. In the Location field, tap the Up/Down arrows to 

select an available location to assign as the new speed 
dial entry. The first speed dial location is reserved for 
your voice mail. 

4.  
By memorizing the position in the Speed Dial list of a 
number, you can dial the number by tapping and hold the 
position number on the dialer keypad; if the number holds a 
position of 10 or more, tap the first number, and then tap and 
hold the second to dial. 
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1. Go to Phone and tap  
 

2. Find the call details by first selecting the category it is 
filed under. For example, if it is in All calls select All 
calls from the drop down menu in the top-left corner. 

 
3. Use the navigation pad to find the number and then tap 

  or the icon to the left of the number you wish to 
call. 

 
4. Call History icons include : 

  
z incoming calls ;  
z outgoing calls;  

  
z missed calls. 
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Enter the international emergency number 112 then tap  
or press   button. 
 

 Some mobile phone service providers may require that 
a SIM card is inserted and/or a PIN entered in order to 
112. Consult with your service provider for more 
information. 

 Additional emergency numbers may be included on 
your SIM card. Consult with your mobile service 
provider for more information. 
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1. Tap and hold the    key until the+ sign appears. The 
+ replaces the international prefix of the country of 
where you are calling. 

2. Enter the full phone number you want to dial. It 
includes country code, area code (without the leading 
zero) and phone number. 

3. Tap    or press  . 
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1. Tap Answer, or press   on your device. 
2. Tap Ignore or press    to reject the call. 
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Once an incoming or outgoing call is proceeding, you can 
press   or tap   to end the call. 

Your device notifies you when you have another incoming 
call and gives you the choice of rejecting or accepting the call.  
If you accept, you can choose to switch between the two 
callers or set up a conference call between all three parties.  A 
conference call can include up to six people. 
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1. Tap Answer to the take the 2nd call and put the 1st on 
hold. 

2. To end the 2nd call and go back to the 1st, tap   
or press   . 
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You can choose to swap backwards and forwards between 2 
callers by pressing  . 
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1. Either put a call on hold, dial a 2nd number and wait 
for it to be picked up. Or, accept a 2nd incoming call 
when you already have one in progress. 

2. In the screen that appears tap   . 
3. If the conference connection is successful the word 

Conference will appear at the top of the phone dialer 
screen (see right). 

4. To add additional people to your conference call tap 
 , key in the number, and then   to 

return and continue. 
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Regardless of whether you call from the Dialer, Contacts, 
Call Log, or Speed Dial, you can take notes during a call. 
After you have finished the note it will be saved as an 
attachment to your call in one of the Call Log folders. 

a. To make a note: 

1. After you have entered a number and tapped    or 
 , tap the   icon at the bottom of the screen.  

2. Use any of the input methods to record your note 
and then tap OK. You can finish your note during or 
after the call. 

b. To view a note: 
 

1. Tap  , tap and hold the call, and then from the 
pop up menu tap view note. (The icon  indicates a 
note). 

2. Or, go to Notes, and then tap the name of the file 
from the list.  
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The first speed dial location defaults as your voice 
mailbox. When you insert your SIM card into your 
Pocket PC Phone, it will automatically detect and set as 
default the voice mailbox number of your mobile service 
provider. 
 
To retrieve your voice mail: 
 
On the Phone screen, tap   or press the left side of 
the navigation pad, select  Voice Mail and then 
press  

Tap    on the phone screen to pop-up the call 
history list to the right: 
 

 ��
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1. Find the call details you want to add. 
2. Press and hold the stylus or press and hold the 

navigation pad center; select  Save to Contacts in 
the pop-up menu that appears .  

3. In the Save to Contacts screen, add additional 
contact details and press the navigation pad 
center or tap OK. 

 

The call details in the Call History will then be amended 
and displayed under the name of the contact, not their 
telephone number. 
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Call History details all incoming, outgoing, and missed 
calls and also provides a summary of total calls.  Call 
History can also tell you when a call was initiated, how 
long it lasted, and provides easy access to any notes 
taken during the call. 
 

a. Viewing calls details 
 
Tap in the top left corner of the screen and then select a 
category from the drop down menu.  
 
Calls are categorized as follows: 
 

 All Calls - displays all calls made to and from 
the phone in chronological order.  

 Missed   - displays calls that were not 
answered.  

 Outgoing   - displays calls made from the 
phone.  

 Incoming    - displays calls made to the 
phone.  

 By Caller - list calls alphabetically according to 
caller. 

b.To view duration of calls : 
 
Go to Call History, find the call you are looking in, and 
then tap it once. 
 
c. To delete Individual calls from Call History: 
 
Tap and hold the stylus on the call to be deleted, and 
then select delete from the pop up menu. 
 
d. To delete all calls from Call History: 
 

Tap Tools 
z and then Delete all Calls. 
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e. To set limits on the size of your Call  History: 
 

 Tap   
z Call Timers and then the box 
under  Delete call history items older than. 

 In the drop down menu select a time period then 
tap OK 
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Locking your Pocket PC phone prevents access to 
personal data. When you enable this feature, your 
Pocket PC phone will automatically lock after a 
specified time of inactivity. A screen will be displayed 
requiring your Pocket PC phone lock password before 
access is granted. 
 

1. Tap   
z Settings 
z Personal 
z Password. 
2. Select the type of password you would like to 

use: Simple 4 digit password or Strong 
alphanumeric password. 

A strong password must have at least 7 characters that 
are a combination of uppercase and lowercase letters, 
numerals, and punctuation. 

3. Enter the password and, if necessary, confirm the 
password.  

4. Select  how long your mobile device must be 
turned off before the password is required for 
using the device by tapping Prompt if device 
unused for. 
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You can protect your Pocket PC phone from unauthorized 
use by assigning a PIN (Personal Identification Number). 
Your first PIN will be given to you by your mobile phone 
service provider. 
 

1. From the Phone keypad, tap Tools 
z Options  
z 
Phone tab. 

2. Select Require PIN when phone is used. 
3. To change the PIN at any time, tap Change PIN. 

Emergency calls can be placed at any time, without 
requiring a PIN. 
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Using Microsoft _ ActiveSync�  you can synchronize the 
information on your PC with the information on your Pocket PC 
Phone. Synchronization compares the data on your device with 
your PC and updates both with the most recent information. 
With ActiveSync, you can: 
 

 Keep Pocket Outlook data up-to-date by synchronizing 
your device with Microsoft Outlook data on your PC.  

 Choose to synchronize Inbox, Calendar, and Contacts 
with a server so that you have the latest information, 
even when your desktop computer is turned off. 

 Copy  (rather than synchronize)  files between your 
device and your desktop PC.  

 Control when synchronization occurs by selecting a syn-
chronization mode.  

 Select which information types are synchronized and 
control how much data is synchronized. 

By default, ActiveSync does not automatically synchronize all 
types of information. Use ActiveSync options to turn 
synchronization on and off for specific information types. 

Using Server ActiveSync, you can synchronize information 
directly with a Microsoft Exchange Server if your company is 
running Microsoft®   Mobile Information Server 2002 or later. 
 

Before you begin synchronization, install ActiveSync on your 
desktop computer from the Pocket PC Phone 2003 Companion 
CD.  ActiveSync is already installed on your device. 
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After the installation is complete, the New 
Partnership Wizard helps you set up a partnership 
between your phone and your desktop computer 
and/or a server so that you can start synchronizing 
information and customizing your synchronization 
settings. 

In the New Partnership Wizard select 
Synchronize with this desk-top computer.  
Unless you are certain that your company 
is running Microsoft Mobile Information 
Server 2002 or later and you know the 
server name, then choose Synchronize 
with Microsoft Mobile Information 
Server and/or this desktop computer. For 
more information, contact your network 
administrator or service provider. 

Your first synchronization will automatically begin 
when you finish using the wizard. After the first 
synchronization, you will notice that your Outlook 
information now appears on your pocket PC 
phone. 

Select the items you want in the 
synchronization setting then you can 
start to synchronize your data between 
your device and your PC 

Tap to connect and synchronize 

View connection status 

Tap to stop synchronization 
 
View synchronization status 

Tap to synchronized via IR or change 
synchronization settings 

This section provides an overview of the types of Outlook 
information you can synchronize. By default, ActiveSync 
does not automatically synchronize all types of Outlook in-
formation. Use ActiveSync options to turn synchronization 
on and off for specific information types. 
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When you select Inbox for synchronization in ActiveSync, 
e-mail messages are synchronized as part of the general 
synchronization process. During synchronization, the fol-
lowing events occur : 
 

 Messages are copied from the Outlook Inbox folder 
on your desktop computer, or from a Microsoft 
Exchange Server, to the Inbox  folder on your 
Pocket PC Phone. 

 By default, when synchronizing Inbox information 
with your desktop computer,  you will  receive only 
messages from the last three days and the first 500 
bytes of each new message. You can also choose to 
download file attachments. 

 The messages on your phone and on your desktop 
computer are linked. When you delete a message on 
your phone, it is deleted from your desktop 
computer the next time you synchronize, and vice 
versa. 

 Messages in subfolders in other e-mail folders in 
Outlook are synchronized only if the folders have 
been selected for synchronization in the Inbox  on 
your  Pocket PC Phone. 

 

SMS messages are not received in your Inbox 
through synchronization. Instead, they are sent  to 
your phone by way of  your service provider.  

 Calendar items stored on your Pocket PC Phone can 
be synchronized with calendar items stored on your 
desktop PC and/or on a Microsoft Exchange Server. 
By default, calendar items from the last two weeks 
will be synchronized. 

 Calendar items created on your Pocket PC Phone are 
copied to your desktop PC and/or server during 
synchronization, and vice versa. Similarly, Calendar 
items that are deleted from your phone are deleted 
from your desktop computer and/or server during 
synchronization, and vice versa. This keeps your 
information up-to-date in all locations 
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 Contacts stored on your phone can be synchronized 
with contacts stored on your desktop computer or on 
a Microsoft Exchange Server. By default, all of your 
contacts will be synchronized. 

 Contacts created on your phone are copied to your 
desktop computer and/or server during 
synchronization, and vice versa. Similarly, contacts 
that are deleted from your phone are deleted from 
your desktop computer and/or server during 
synchronization, and vice versa. This keeps your 
information up-to-date in all locations. 

 

 Tasks stored on your phone can be synchronized with 
tasks stored on your desktop computer. Task 
synchronization is automatically selected in 
ActiveSync. By default, all of your incomplete tasks 
will be synchronized. 

 Tasks created on your phone are copied to your 
desktop computer during synchronization, and vice 
versa. Similarly, tasks that are deleted from your 
phone are deleted from your desktop computer during 
synchronization, and vice versa. This keeps your 
information up-to-date in all locations. 

 

Tasks can be synchronized only with your desktop 
computer.  They cannot be synchronized with a 
server. 

You can use an infrared connection to create a direct con-
nection between your phone and another mobile device or 
desktop computer quickly. This method is ideal for quickly 
switching between multiple devices since there are no cables 
or adapters to change. When creating a partnership, you must 
connect using infrared, a cable, or a cradle connection. 
 
For more information about synchronizing using an infrared 
connection or other connection types, see ActiveSync Help on 
your desktop computer. 
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Using infrared (IR), you can also send and receive information, 
such as contacts and appointments, between two devices. 
 

a. To send information: 
 

1. Switch to the program where you created the item you 
want to send and locate the item in the list. 

2. Align the IR ports so that they are unobstructed and 
within close range. 

3. Tap and hold the item, and tap Beam Item on the pop up 
menu. 

 

You can send items, but not folders, from File Explorer. 
Tap and hold the item you want to send, and then tap 
Beam File on the pop up menu. 
 

b. To receive information: 
 

1. Align the IR ports so that they are unobstructed and 
within close range. 

2. Have the owner of the other device send the information 
to you. Your device will automatically receive it. 

Whenever ActiveSync cannot successfully synchronize your 
information, it displays an error on your phone. 

Press the Action button when the error text is displayed. 
ActiveSync will then display more information about the error 
that occurred. 
 

Some types of errors can interfere with automatic 
synchronization. If you suspect that a scheduled 
automatic synchronization has not occurred, you should 
attempt to manually synchronize your information. 
Successfully completing manual synchronization will 
reset automatic synchronization. For more information, 
see the Synchronizing Information section of 
ActiveSync Help on your desktop computer. 
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You can adjust device settings to suit the way you work. To see 

available options, tap   
z Settings 
z Personal or System tab 
located at  the bottom of the screen. 

The Settings window has three tabs – Personal, System and 
Connections. Each of which has its own set of settings. The 
succeeding sections show the configuration page of Personal 
and System, the Connections setting will be explained in the 
next chapter. 
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To change the assignments for your device's four program 
buttons : 

 Tap   
z Settings 
z Personal 
z  Buttons. 
 Select a button, a program in Button Assignment, and then 

tap OK. 
 In the Up/Down Control tab Delay before first repeat 

changes the time elapsed before scrolling begins.  Repeat rate 
changes the time it takes to scroll from one item to the next. 
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Tap  
z Settings 
z Personal tab 
z Input. 
 Select an input method and change desired options on the 

Input Method tab; Select  desired option for  word completion 
on the Word Completion tab, and options for writing and 
recording on the Options tab. These options apply to any 
program on the device where you can record or write. 
 

You can also change input Options by tapping the   arrow 
and then options 

�+���#�
To add the programs you use most often to start   . 

 Tap  
z Settings 
z Personal tab 
z Menus. 
 Select the programs you want, and then tap OK. 
 On the New Menu tab, you can select Turn on New button 

menu and then select the items to appear on the menu.  When 
you do this, an arrow appears next to New in the command bar 
of certain programs such as Pocket Word, Pocket Excel, 
Contacts, Calendar and Tasks.  You can tap this arrow and then 
tap a new item to create. 

You can create subfolders and shortcuts to appear under  .  In 

ActiveSync on your desktop PC, click Explore 
z Double-click 

My Pocket PC 
z click Windows 
z click Start Menu 
z then 
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Tap   
z Settings 
z Personal tab 
z Owner Information. 
 On the Identification tab, enter your personal information. 

Select Show information when device is turned on so that if you 
lose your device, it can be returned to you.  

 On the Notes tab, enter any additional text you want to 
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Tap  
z Settings 
z Personal 
z Password. 
 To select how long your mobile device must be turned off 

before a password must be entered, check Prompt if device 
unused for. 

Select the type of password you would like to use. A strong 
password must have at least 7 characters that are a combination 
of uppercase and lowercase letters, numerals, and punctuation. 

 Enter the password and, if necessary, confirm the password.  

If your device is configured to connect to a network, use a 
strong password to help protect network security. 
If you forget your password, you must clear the memory before 
you can access your device.  This will erase all files and data 
you have created and programs you have installed.  For more 
information about clearing memory, please see Appendix A. 
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Tap   
z Settings 
z Personal tab 
z Sounds & Notifications. 
 On the Volume tab, you can select the actions for which you 

want to hear sounds. If you don’t want to hear sounds, move the 
System volume slider to Silent.  
 

 On the Notifications tab, you can customize how you are 
notified about different events. Select the event name and then 
select the type of reminder. You can select a special sound, a 
message, or a flashing light.  
 

Turning off sounds and the notification light helps conserve 
battery power. 
Use Phone settings to change the ring type and volume for your 
phone.  For more details see the Phone Setting section in 
Chapter 3. 
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You can customize the Today screen the following ways:  

a. To change the background: 

Tap   
z Settings 
z Personal tab 
z today. 
On the Appearance tab, select the desired theme for the 

background. To use your own background, select Use this 
picture as the background then tap Browse to locate the desired 
file.  

 Choose a folder and tap the file you want then tap OK. 
 

b. To customize the information you want displayed: 

Tap   
z Settings 
z Personal tab 
z Today 
z then Items tab. 
Uncheck a box to remove its information. 
 To change an item's position select it then tap Move Up or 

Move Down.  
 To choose how long the Today screen is displayed, 

select/deselect Display Today screen if device is not used for, 
then the number of hours. 
 

c. To customize Tasks or Calendar: 
Select Tasks or Calendar, and then Options to further 
customize.  
 

�You can find additional pictures on the Pictures   companion 
program. See detailed information in Chapter 9.   
�Recommend picture size is 240x320 pixels in .jpg file. 
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 Tap   
z Settings 
z System tab 
z Backlight. 
 Tap Battery power tab to turn on/off the back-light when 

using battery power. 
 Tap External power tab to turn on/off the back-light when 

using external power. 
 Tap Brightness tab to adjust the brightness level. 

 



 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Using the backlight while on battery power substantially 
reduces battery life. 
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Tap   
z Settings 
z System tab 
z Clock. 
 
If you visit a particular time zone often, select it as your 
Visiting time zone on the Time tab so that you can quickly see 
the correct date and time.  
 
You can use your device as a travel alarm clock by setting a 
wake-up alarm on the ACs tab. Tap the alarm icon to select the 
type of alarm you want.  
 
To change the appearance of the date and time, go to Regional 

by tapping   
z Settings 
z System tab 
z Regional Settings. 
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Tap   
z Settings 
z System tab 
z Memory. 
 
The Main tab displays the amount of memory the system has 
allocated to file and data storage versus program storage. This 
tab also displays the amount of memory in use versus the 
available memory. For information about making memory 
available, see Free Memory in Appendix A. 
 
The Storage Card tab displays how much memory is available 
on the storage card that is inserted into your device. If you have 
more than one card inserted, tap the list box and then the name 
of the storage card whose information you want to view. 
 
The Running Programs tab displays the list of currently active 
programs. You can stop a program by selecting it in the list and 
tapping Stop. You may need to stop a program if it becomes 
unstable or program memory is low. 
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Tap   
z Settings 
z System tab 
z Power. 
 
The Battery tab displays the amount of battery power 
remaining. Battery power depends on the battery type and how 
the device is being used.  
 
On the Advanced tab you can select options for turning off your 
device to conserve battery power. To conserve the most power, 
select the option that turns off the device after 3 minutes or less. 
 

You can easily view and change settings, such as the ring type 
and ring tone to be used for incoming calls, and the keypad tone 
to be used when entering phone numbers. You can also protect 
your phone from unauthorized use. There are two ways to 
change phone settings: 
 

 Tap   
z Settings 
z Personal tab 
z Phone. 
 

To change phone settings from the Phone keypad 
z Tap 

Tools 
z Options 
z Phone tab. 
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a. Ring Type 
You can change the way that you are notified of incoming calls. 
For example, you can choose to be notified by a ring, a 
vibration, or a combination of both. 
 
Tap the Ring type list, then select the desired option. 
 



 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Feature  Function  
Call Barring  �(�Q�D�E�O�H�V���\�R�X���W�R���E�O�R�F�N���L�Q�F�R�P�L�Q�J���D�Q�G���R�U���R�X�W�J�R�L�Q�J���F�D�O�O�V����

Caller ID  �,�G�H�Q�W�L�I�L�H�V���F�D�O�O�H�U���E�\���G�L�V�S�O�D�\�L�Q�J���W�K�H�L�U���Q�D�P�H���D�Q�G���R�U���S�K�R�Q�H���Q�X�P�E�H�U����

Call 
Forwarding  

�(�Q�D�E�O�H�V�� �\�R�X�� �W�R�� �I�R�U�Z�D�U�G�� �D�O�O�� �R�U�� �V�H�O�H�F�W�H�G�� �L�Q�F�R�P�L�Q�J�� �F�D�O�O�V�� �W�R�� �D�� �G�L�I�I�H�U�H�Q�W��

�Q�X�P�E�H�U����

Call Waiting  �1�R�W�L�I�L�H�V���\�R�X���R�I���D�Q���L�Q�F�R�P�L�Q�J���F�D�O�O�V���Z�K�L�O�H���\�R�X�
�U�H���D�O�U�H�D�G�\���R�Q���W�K�H���S�K�R�Q�H������

 
 
 
 
 
 
 
 
 

b. Ring Tone 
 
Tap the Ring tone list, then select the sound you want to use. 
To use .wav, .mid, or .wma files as ring tones, use ActiveSync 
on your PC to copy the file to the /Windows/Rings folder on 
your device. Then, select the sound from the Ring tone list.  
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You can change the tone you hear when entering a phone 
number on the keypad. If set to Tones, the tone is heard 
continuously for as long as the number on the keypad is 
pressed. If set to Beep, the tone is heard only for one or two 
seconds. 
 
Tap the Keypad list, and then select the option you want. 
To prevent tones from being heard when entering a phone 
number, select Off. 
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Services settings on the Settings 
z Phone 
z Services tab are 
primarily used to set options for incoming calls, such as Call 
Forwarding, Call Waiting, and Caller ID. 

Tap Get Settings to access the settings for a service. 

To change service settings from the phone keypad, tap Tools 
z 

Options 
z Services tab 
z tap a service 
z Get Settings. 
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With network settings, you can view available networks, 
determine the order in which your phone accesses another 
network if the current one is unavailable, and specify whether 
you want to change networks manually or automatically. The 
current network will remain active until you change it, lose your 
signal, or change your SIM card. 
 

The network currently in use will be listed at the top of the 
screen. 
When your current network is unavailable, tap Select Network 
to select an alternate. 
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Microsoft Pocket Outlook includes Calendar, Contacts, Tasks, Inbox, 
and  Notes. You can use these programs individually or together. For 
example, e-mail addresses stored in Contacts can be used to address 
e-mail messages in Inbox.  
Using ActiveSync, you can synchronize information in Microsoft 
Outlook or Microsoft Exchange on your PC with your device. You 
can also synchronize this information directly with a Microsoft 
Exchange server. Each time you synchronize, ActiveSync compares 
the changes you made on your device and PC or server and updates 
both PC with the latest information.  
For information on using ActiveSync, see Chapter 4 Synchronizing 
Information or ActiveSync Help on the PC. 

Use Calendar to schedule appointments, including meetings and other 
events. You can check your appointments in one of several views 
(Agenda, Day, Week, Month, and Year) and easily switch views by 
using the View menu. 

 Tap to go to today. 
 Tap to display or edit the appointment details. 
 Tap to create a new appointment. 
 Tap to change the first day of the week. 

 

You can customize the Calendar display, such as changing the first 
day of the week, by tapping Options on the Tools menu. 
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If you are in Day or Week view, tap the desired date and time for the 
appointment, then tap New : 

 Tap tab appropriate fields, then using the input panel, enter a 
description and a location. 

 If needed, tap the date and time to change them. 
 Enter other desired information. You will need to hide the input 

panel to see all available fields. 
 To add notes, tap the Notes tab. You can enter text, draw, or create 

a recording. For more information on creating notes, see Notes: 
Capturing Thoughts and Ideas later in this chapter. 

 When finished, tap OK to return to the calendar. 
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If you select Remind me in an appointment, your device will remind 

you according to the options set in   
z Settings 
z Personal tab 
z 
Sounds & Notifications. 
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When you tap an appointment in Calendar, a summary screen is 
displayed. To change the appointment, Tap Edit 

�
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You can use Calendar to set up meetings with users of Outlook or 
Pocket Outlook. The meeting request will be created automatically 
and sent either when you synchronize Inbox or when you connect to 
your e-mail server. Indicate how you want meeting requests sent by 
tapping Tools and then Options. If you send and receive e-mail 
messages through ActiveSync, select ActiveSync. 
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Create an appointment. 
 Hide the input panel, and then tap Attendees. 
 Select the meeting attendees from the list of e-mail addresses 

you’ve entered in Contacts.  
 The meeting notice is created automatically and placed in the 

Outbox  folder. 
For more information on sending and receiving meeting requests, see 
Calendar Help and Inbox Help on the device. 
 

Contacts maintains a list of your friends and colleagues so that you 
can easily find the information you are looking for, whether you are 
at home or on the road. Using the device 's infrared (IR) port, you can 
quickly share Contacts information with other device users.  

Select the category of contacts you want displayed in the list. 
 Tap and enter part of a name to quickly find it in the list. 
 Tap to see additional phone numbers and e-mail addresses. 
 Tap  to display or edit the contact details. 
 Tap and hold to display a pop-up menu of actions. 
 Tap to create a new contact. 

 



 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

To change the way information appears in the list, tap Tools and 
then Options. 
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Tap   
z Contacts 
z New. 
 Using the input panel, enter a name and other contact 

information. You will need to scroll down to see all available fields. 
 To assign the contact to a category, scroll to and tap Categories 

and select a category from the list. In the contact list, you can 
display contacts by category. 

 To add notes, tap the Notes tab. You can enter text, draw, or 
create a recording. For more information on creating notes, see 
Notes: Capturing Thoughts and Ideas later in this chapter. 

 When finished, tap OK to return to the contact list. 
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There are 6 ways to find a contact: 

 Press and hold the top of the navigation pad until alphabetical 
letters appear on the screen in large type. Then use the navigation 
pad to scroll through the alphabet and select a letter. 

 Tap one of the grouping of letters displayed across the top of the 
screen.   

 In the contact list, enter a contact name in the box under the 
navigation bar. To show all contacts again, clear text from the box 
or tap the arrow button to the right of the box.  

 In the contact list, tap the category list (labeled All Contacts by 
default) and select the type of contact that you want displayed. To 
show all contacts again, select All Contacts. To view a contact not 
assigned to a category, select No Categories.  
To view the names of companies your contacts work for, in the 

contact list, tap View 
z By Company. The number of contacts that 
work for that company will be displayed to the right of the 
company name. 

 Tap   
z Find, enter the contact name, select Contacts for the 
type, and then tap Go. 
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When you tap a contact in the contact list, a summary screen 
is displayed. To change the contact information, tap Edit. 
 

Use Tasks to keep track of what you have to do.  
 

To change the way information is displayed in the list, tap 
Tools and then Options. 
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Tap   
z Tasks 
z New. 
 Using the input panel, enter a description. 
 You can enter a start date and due date or enter other 

information by first tapping the field. If the input panel is 
open, you will need to hide it to see all available fields. 

 To assign the task to a category, tap Categories and select a 
category from the list. In the task list, you can display tasks by 
category. 

 To add notes, tap the Notes tab. You can enter text, draw, 
or create a recording. For more information on creating notes, 
see Notes: Capturing Thoughts and Ideas later in this chapter. 

 When finished, tap OK to return to the task list. 
 

To quickly create a task with only a subject, tap Entry Bar on 
the Tools menu. Then, tap Tap here to add a new task and 
enter your task information. 
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When you tap a task in the task list, a summary screen is 
displayed. To change the task, tap Edit 

Notes quickly capture thoughts, reminders, ideas, drawings, 
and phone numbers. You can create a written note or a record-
ing, or include a recording in a note. If the note list is 
displayed, it will be created as a stand-alone recording. 
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Tap   
z Notes 
z New. 
 Create your note by writing, drawing, typing, and 

recording. For more information about using the input panel, 
writing and drawing on the screen, and creating recordings, 
see Chapter 2 Entering Information. 
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You can set up connections to the Internet and to your corporate 
network at work in order to do such activities as browse the 
Internet or intranet, send and receive e-mail and instant 
messages, and synchronize information using ActiveSync. 
 
Connections can be made using a modem, wireless network, or 
network (Ethernet) card. A modem connection can be used to 
set up connections with an external modem, or through your 
mobile phone network using a cellular line or GPRS. You have 
the following connection options: 
 

Use the infrared (IR) port on your device to send and receive 
files between two devices. 
Connect to your mobile Internet service provider (ISP) and you 
can send and receive e-mail messages by using Inbox and view 
Web or WAP pages by using Microsoft® Pocket Internet 
Explorer. The communication software for creating a wireless 
ISP connection is already installed on your device. Your service 
provider will provide software needed to install other services, 
such as paging and fax services. 
Connect to the network at your company or organization, and 
you can send and receive e-mail messages by using Inbox and 
view Web or WAP pages by using Microsoft® Pocket Internet 
Explorer, and synchronize with your PC. 
Connect to your virtual private network (VPN) at the company 
or organization where you work, where the added security 
means that you can access the full resources of your company’s 
network. For example, you can use File Explorer to access the 
files of computers on that network.  
 

Your device has two groups of connection settings: My ISP and 
My Work Network. My ISP settings are used to connect to the 
Internet, and My Work Network settings can be used to connect 
to any private network, such as the corporate network you use at 
work. Simply fill in the settings and you’ll be ready to start 
connecting. 
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You can use GPRS to connect to your mobile ISP, and use the 
connection to send and receive e-mail messages and view Web 
or WAP pages. 
 

 Obtain the following information from your ISP: ISP server 
phone number, user name, and password.  

 Tap   
z Setting 
z Connections tab 
z Connections  
In My ISP, tap Add a new modem connection. 
 Create a modem connection. 

Wireless connections can be made via a mobile phone network 
or GPRS. If you are using a mobile phone network to connect, 
in the Select a modem list, tap Cellular Line. If you are using 
GPRS, tap Cellular Line (GPRS). 
 

 To start the connection, begin using the desired program. For 
example, switch to Pocket Internet Explorer and browse to a 
Web page. Your device will automatically connect. 
 

To set up a network card or wireless network connection to your 
ISP, then add a new connection under My Work Network. 
�To change modem connection settings, in either My ISP or My 
Work Network, tap Manage existing connections. Select the 
desired modem connection, tap Settings, and follow the 
instructions on the screen. 

To view additional information for any screen, tap . 

This program allow you to choose the line type when you make 
a circuit switch data connection 

The default setting on this device is customized as the best 
setting for use. Don't change this setting unless you have trouble 
on circuit switch data connection. 
 

To change a CSD Line Type: 

Tap    
z Settings 
z Connections 
z then CSD Line Type. 
 Tap under Data rate and select a value, then tap under 

Connection element and choose a type from that drop-down 
menu. Tap OK.  
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This program allows you to choose the GPRS setting method 
when you make a GPRS connection.  There 2 authentication 
methods required to be set up: 
 

�PAP authentication   
 Password Authentication Protocol, protocol used in 
authentication which users clear text passwords and is the least 
sophisticated of authentication protocols. 
CHAP authentication  
Challenge Handshake Authentication Protocol, protocol used to 
negotiate the most secure form of encrypted authentication 
supported by both server and client. 
 

Changing these setting may cause your data communications to 
no longer operate.  Please consult your service provider before 
altering these settings. 

Set up a WAP gateway 
To access WAP sites through Pocket Internet Explorer, con-
figure your device to use a WAP gateway. Use the following 
steps to create a new set of connections to the Internet with 
WAP gateway settings. 
 

 Get the following information from your ISP :  
ISP server phone number, user name, and password. Also, contact 
your mobile phone service provider and ask for your WAP gateway 
server name and port number. 

 Tap   
z Settings 
z Connections tab
z Connections 
z Tasks tab. 
 Tap Edit my proxy server. If a proxy server has not been set up, 

tap Set up my proxy server. 
 In Programs that automatically connect to the Internet should 

connect using, tap New and enter a name for the ISP connection. 
 On the Proxy Settings tab, select This network connects to the 

Internet and This network uses a proxy server to connect to the 
Internet. 

 If necessary, in the Proxy server box, enter the proxy server name. 
 Tap Advanced. 
 In the WAP box, enter the WAP gateway server name. Under Port, 

enter the port number. The most common WAP port number is 9201. 
 Create a modem connection. Also, if necessary, set dailing rules. 
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Once connected, you can use Microsoft�  Pocket Internet 
Explorer to view Web HTML, cHTML, xHTML and WAP 
pages. You can browse in either of these ways: 
 

During synchronization with your PC, download your favorite 
links and mobile favorites that are stored in the Mobile 
Favorites folder in Internet Explorer on the PC. 
 

Connect to an Internet service provider (ISP) or network and 
browse the Web. To do this, you will need to create the 
connection first, as described in section 7.2 Connect to the 
Internet. 
 
When connected to an ISP or network, you can also download 
files and programs from the Internet or intranet. 
 
To synchronize and download your favorite links from your 
desktop computer, tap the sync option Favorites in ActiveSync 
on your desktop PC. 
 

To switch to Pocket Internet Explorer: 
Tap   
z Internet Explorer. 
You can use Pocket Internet Explorer to browse mobile 
favorites and channels that have been downloaded to your 
device without connecting to the Internet. You can also connect 
to the Internet through an ISP or a network connection and 
browse the Web/ WAP page(s). 

To browse the Internet: 
In the address bar that appears at the top of the screen, enter 

the Web address you want to visit. 
 Tap   to go to the web address you entered.  
 Tap  , the Favorites button, then tap the favorite you want 

to view.  
 Tap   to go back to the Homepage you set. 
 Tap   to refresh the web page on the screen. 
 Tap the arrow    to choose from previously entered 

addresses. 
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To view mobile favorites and channels: 
To display your list of favorites, tap .  
 Tap the page you want to view.  
 You will see the page that was downloaded the last  time you 

synchronized with your PC. If the page is not on your device, the 
favorite will be dimmed. To download the page to your device, 
you will need to synchronize with your PC again, or connect to 
the Internet to view the page. 
 

To add a favorite link while using the device, go to the page you 
want to add, tap and hold on the page, and tap Add to Favorites. 
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Only items stored in the Mobile Favorites folder in the 
Favorites folder in Internet Explorer on your PC will be 
synchronized with your device. This folder was created 
automatically when you installed ActiveSync. 
 

Favorite Links 
During synchronization, the list of  favorite links in the 
Mobile Favorites folder on your PC is synchronized 
with Pocket Internet Explorer on your device. Both your 
PC and your device are updated with changes made to 
either list each time you synchronize. Unless you mark 
the favorite link as a mobile favorite, only the link will 
be downloaded to your device, and you will need to 
connect to your ISP or network to view the content. For 
more information on synchronization, see ActiveSync 
Help on the PC. 
 

Mobile Favorites  
If  you are using Microsoft Internet Explorer 5.0 or 
higher on your PC, you can download mobile favorites 
to your device. Synchronizing mobile favorites 
downloads Web content to your device so that you can 
view pages while you are disconnected from your ISP 
and PC. 
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a. To create a mobile favorite: 
In Internet Explorer on your desktop computer, click Tools 

and then Create Mobile Favorite. 
 To change the link name, enter a new name in the Name 

box.  
 In Update, select a desired update schedule. 
 Click OK. Internet Explorer downloads the latest version 

of the page to your desktop computer. 
 To limit the number of download links, open Internet 

Explorer on your desktop PC then Favorites.   
Move your mouse through Mobile Favorites to the mobile 
favorite you want to change. Right-click the mobile favorite 
and then Properties; in the Download tab, specify 0 or 1 for 
the number of linked pages you want to download. 

 Synchronize your device and desktop computer. Mobile 
favorites that are stored in the Mobile Favorites folder in 
Internet Explorer are now downloaded to your device. 
 

If you did not specify an update schedule in step 3, you will 
need to manually download content to keep the information 
updated on your desktop computer and device. Before 
synchronizing with your device, open Internet Explorer on 
your desktop computer, click Tools and then Synchronize. 
You will see the last time content was downloaded to the 
desktop computer, and you can manually download content if 
needed. 

b. Saving Device Memory 
Mobile favorites take up storage memory on your device. To 
minimize the amount of memory used: 

In ActiveSync on your desktop 
z click Options 
z select 

Favorites 
z tap Settings and then Customize. 
 You can then deselect Synchronize Images, Synchronize 
Sound and/or Synchronize offline content pages to stop 
pictures and sounds, or some mobile favorites from being 
downloaded to the device 

You can add a button to the Internet Explorer toolbar for 
creating mobile favorites.  

Open Internet Explorer on your desktop computer 
z click 

View 
z Toolbars 
z and then Customize 
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AvantGo is a free interactive service that gives you access to 
personalized content and thousands of popular Web sites. You 
can subscribe to AvantGo channels directly from your device. 
Then, you synchronize your device and PC, or connect to the 
Internet to download the content. For more information, visit 
the AvantGo Web site http://avantgo.com/help. 
 

To sign up for AvantGo: 
In ActiveSync options on the desktop computer, turn on 

synchronization for AvantGo. 
 Open Pocket Internet Explorer on your device, then tap the 

Favorites button to display your list of favorites. 
 Tap the AvantGo Channels link. 
 Follow the directions on the screen. You will need to 

synchronize your device with your desktop computer and then 
tap the My Channels button to complete the AvantGo setup. 
 

When synchronization is complete, tap the AvantGo Channels 
link in your list of favorites to see a few of the most popular 
channels. To add or remove channels, tap the Add or Remove 
link 

Using the Terminal Services Client, you can log onto a Windows 
NT server type PC that is running Terminal Services software and 
use all of the programs that are available on that PC from your 
mobile device. For example, instead of running Microsoft Pocket 
Word, you can run the PC version of Microsoft Word and access 
all of the .doc files on that PC from your device. 
 

You cannot use Transcriber when entering information in 
Terminal Services. You must use Keyboard, Block Recognizer, or 
Letter Recognizer. 
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To connect to a Terminal Server : 
Start a remote connection to the server via your wireless modem 
connection. 

 Tap   
z Programs 
z Terminal Services Client. 
 If connecting to a server you have previously connected 

used, tap its name in Recent Servers.  
 To connect to a new server, enter the server’s name in the 

Server box. Select the Limit size of desktop to fit on the screen 
check box only when using applications that have been 
specifically sized for use with Pocket PC. 

 Tap Connect. 

If the network administrator has configured Terminal Services 
Client to reconnect to disconnected sessions, and you 
previously disconnected from a Terminal Server without ending 
the session, the Terminal Services Client reconnects to that 
session. 
 

For more information about the connection of Terminal Ser-

vices Client, tap   
z Help 
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You can set up a connection to an e-mail server so that you can 
send and receive e-mail messages by using a modem or network 
connection and Inbox on your device. 
 

You can use multiple e-mail services to receive your messages. 
For each e-mail service you intend to use, first set up and name 
the e-mail service. If you use the same service to connect to 
different mailboxes, set up and name each mailbox connection. 
 
The ISP or network must use a POP3 or IMAP4 e-mail server 
and an SMTP gateway. 
 

To set up an e-mail service: 
Open Inbox on your device, tap Accounts, and then New 

Account. Follow the directions in the New Account  Wizard. 
 Fill in you e-mail address then tap Next. 

Next will initiate auto-configuration  which attempts to connect 
your Pocket PC Phone to your e-mail server and automatically 
download the necessary e-mail connection settings. 
If auto-configuration is successful you can immediately begin 
sending/receiving e-mails. 
If auto-configuration is unsuccessful you will need to manually 
enter the settings. 
 

Enter Your name, User name and Password, then tap Next. 
 



 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 From the drop down menu select the Account type that your 
e-mail provider supports (POP3 or IMAP4). 

 Enter a Name for your e-mail account then tap Next. 
 

 Enter the your e-mail provider’s server name information for 
Incoming mail and Outgoing mail, then tap Finish. When 
finished, to connect to your e-mail server, tap Accounts and 
then Connect. 
 
For an explanation of a screen, tap    and then Help. 

Sending and Receiving E-mail 
You can use Inbox to send and receive e-mail messages in 
either of these ways:  
Synchronize e-mail messages with Microsoft Exchange or 
Microsoft Outlook on your PC. 
Connect directly to an e-mail server through an Internet service 
provider (ISP) or a network. 
You also can use Inbox to send and receive SMS; it supports 8 
bits of data with class 0, 1, 2, 3, and Unstructured Supple-
mentary Service Data (USSD) as well. 

a. Synchronizing E-mail Messages 
E-mail messages can be synchronized as part of the general 
synchronization process. You will need to enable Inbox 
synchronization in ActiveSync. For information on enabling 
Inbox synchronization, see ActiveSync Help on the PC. 

During synchronization: 
Messages are copied from the mail folders of  Exchange or 
Outlook on your PC to the ActiveSync folder in Inbox on your 
device. By default, you will receive messages from the past five 
days only, and the first 100 lines of each message. 
E-mail messages in the Outbox folder on your device are 
transferred to Exchange or Outlook, and then sent from those 
programs. 



 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
  
 
 
 
 

E-mail messages in folders must be selected in ActiveSync on 
your PC in order to be transferred. 

b. Connecting Directly to an E-mail Server 
 
Once your e-mail account is set up and you're connected, new 
messages will be downloaded to the device's Inbox folder, and 
messages in the device Outbox folder will be sent. 
 
When you delete a message on your device that was 
downloaded from your e-mail server, it will also be deleted 
from the e-mail server the next time you connect. 
 
You can work online or offline. When working online, you read 
and respond to messages while connected. Messages are sent as 
soon as you tap Send, which saves space on your device. 
 
When working offline, once you have downloaded new 
message headers or partial messages, you can disconnect from 
the e-mail server and then decide which messages to download 
completely. The next time you connect, Inbox downloads the 
complete messages you have marked for retrieval and sends the 
messages you have composed. 
 

c. Using the Message List 
Messages you receive are displayed in the message list. By 
default, the most recently received messages are displayed first 
in the list. 
When you receive a message, tap to open it. Unread messages 
are displayed in bold. 



 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

You can mark the messages that you want to retrieve in full 
during your next synchronization or e-mail server connection. 
In the message list, tap and hold the message you want to 
retrieve. On the pop up menu, tap Mark for Download. The 
icons in the Inbox message list provide  visual indication of 
message status. 
 
Specify your downloading preferences when you set up the 
service or select your synchronization options. You can 
change them at any time: 

 Change options for Inbox synchronization using 
ActiveSync options. For more information, see ActiveSync 
Help. 

 Change options for direct e-mail server connections in 
Inbox on your device. Tap Tools and then tap Options. On the 
Account  tab, tap the service you want to change. Tap and 
hold the service and select Delete to remove a service. 
 

d. Creating an E-mail message 
Tap New.  
 In the To field, enter either e-mail address of one or  more 

recipients, separating them with a semicolon, or select a name 
from the contact list by tapping the Address Book  button. 
All e-mail addresses entered in the e-mail fields in Contacts 
appear in the Address Book. 

SMS messages can be sent by entering the SMS numbers in 
the To field. 

 Compose your message. To enter preset or frequently used 
messages, tap My Text and select a message. 

 Tap   button when you have finished the message. If you 
are working offline, the message is moved to the Outbox 
folder and will be sent the next time you connect. 

Swap between e-mail accounts and SMS by tapping Account. 
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SMS messages can be sent in two ways:  
 Go to Inbox, open a new e-mail message and 

select  SMS account in the Account type options. 
 Or you can directly send in phone dialer in the 

Tools menu bar. 
 

To send SMS in phone dialer: 
 

In phone dialer screen, tap Tools, and then Send SMS. 
A new message screen appears in Inbox. 

 In the To field, enter the SMS number of one or more 
recipients, separating them with a semicolon, or select a 
name from the contact list by tapping the Address Book 

  button.  
 Compose your message. To enter preset or frequently  

used messages, tap My Text and select a message. 
 Tap     when you have finished the message. If you 

are working offline, the message is moved to the Outbox 
folder and will be sent the next time you connect. 
 

SMS cannot be used to send e-mail messages.  You can 
tap the double arrows next to the subject field to show 
the complete header.  From the Account list, select an e-
mail account 

If you are sending an SMS message and want to know if 
it was received, tap Edit, Options, and select Request 
SMS text message delivery notification before sending 
the message 
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MSNG” essenger on your mobile device is an instant mes-
saging program that lets you: 
See who is online. 
Send and receive instant  messages. 
Have an instant message conversations with groups of 
contacts. 
Notifies contacts of your on-line status. 
Block contacts from seeing your status or sending you 
messages. 

To use MSN Messenger, you must have a Microsoft Pass-
port TM account or a Microsoft Exchange e-mail account. 
Once you have obtained one of these accounts, you  are 
ready to sign in to MSN Messenger. 
 
If  you have a Hotmail _ or MSN account, you already have 
a Passport.  
To set up a Microsoft Passport account, go   
to�http://www.passport.com 
�To set up a Hotmail account, go to  
�http://www.hotmail.com 

To switch to MSN Messenger: 
Tap   
z Program 
z MSN  Messenger 

Setting Up and Signing In 
 Connect to the Internet using any methods outlined in 

Chapter 7 Getting Connected.  
 Tap anywhere on the MSN Messenger screen,  enter  

your sign-in name and password then tap Sign in. 

Or tap Tools 
z Options 
z Accounts  tab to set your sign-in 
name and password by selecting Enable MSN Messenger 
Service 



 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Your sign-in name is usually in the form : 
username@domain.com 

If you already use MSN Messenger on your PC, your contacts 
will automatically appear on your device 

Working with Contacts 
The MSN Messenger window displays all of your messenger 
contacts at a glance, divided into Online and Not Online 
categories. From this view, while connected, you can chat, 
send e-mail, block a contact from chatting with you, or delete 
contacts from your list using the pop-up menu. 
 

To see others online without being seen, open the Tools 
menu, tap My Status and select Appear Offline. If you block a 
contact, you will appear offline but will remain on the blocked 
contact’s list. To unblock a contact, tap and hold the contact, 
then tap Unblock on the pop up menu. 

Chatting with Contacts 
Tap a contact name to open a chat window. Enter your mes-
sage in the text entry area at the bottom of the screen, or tap 
My Text to enter a preset message, then tap Send. To invite 
another contact to multi-user chat, open the Tools menu, tap 
Invite then tap the contact you want to invite. 

To know if the contact you are chatting with is responding, 
look for the message under the text entry area. 
 

For more information on using MSN  Messenger, tap   and 
then Help 
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By default, messages are displayed in one of five folders for 
each service you have created: Inbox, Deleted Items, Drafts, 
Outbox, and Sent Items. The Deleted Items folder contains 
messages that have been deleted on the device. The behavior of 
the Deleted and Sent Items folders depends on the options you 
have chosen. In the message list, tap Tools and then Options. 
On the Message tab, select your options. 
 
To organize messages into additional folders, create new folders 
by tapping Tools, then Manage Folders. To move a message to 
another folder, in the message list, tap and hold the message and 
then tap Move to on the pop up menu. 
 
Folder behavior with a direct connection to an e-mail server 
 
The behavior of the folders you create depends on whether you 
are using ActiveSync, SMS, POP3, or IMAP4 

If you use ActiveSync, e-mail messages in the Inbox folder in 
Outlook will automatically be synchronized with your device. 
You can select to synchronize additional folders by designating 
them for ActiveSync. The folders you created and the messages 
you moved will then be mirrored on the server. For example, if 
you move two messages from the Inbox folder to a folder 
named Family and you have designated Family for 
synchronization, the server creates a copy of the Family folder 
and copies the messages into that folder. You can then read the 
messages while away from your PC. 

If you use SMS, messages are stored in the Inbox folder of 
SMS category. 

If you use POP3 and you move e-mail messages to a folder 
you created, the link is broken between the messages on the 
device and their copies on the mail server. The next time you 
connect, the mail server will see that the messages are missing 
from the device Inbox and delete them from the server. This 
prevents you from having duplicate copies of a message, but it 
also means that you will no longer have access to messages 
that you move to folders created from anywhere except the 
device. 



 
 
 
 
 
 
 
 
 
 
 
 
 

If you use IMAP4, the folders you created and the e-mail 
messages you moved are mirrored on the server. Therefore, 
messages are available to you anytime you connect to your 
mail server, whether it is from your device or PC. This 
synchronization of folders occurs whenever you connect to 
your mail server; create new folders, or rename/delete folders 
when connected 
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Companion programs consist of Microsoft pocket Word, 
Microsoft pocket Excel, Windows Media Player for Pocket PC, 
and Microsoft Reader and Pictures.  

To switch to a companion program on your device, tap 
Programs on the  menu, and then tap the program 
name. 

Pocket Word works with Microsoft Word on your PC to give 
you easy access to copies of your documents. You can create 
new documents on your device, or you can copy documents 
from your PC to your device. Synchronize documents between 
your PC and your device so that you have the most up-to-date 
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Tap    
z Programs 
z Pocket Word 
z and then New.   A  
blank document appears. 
 
If you have selected a template for new documents in the Tool 


z Options dialog box, that template appears with appropriate 
text and formatting already provided. 
 

You can open only one document at a time; when you open a 
second document, you will be asked to save the first. You can 
save a document you create or edit in a variety of formats, 
including Word (.doc), Pocket Word (.psw), Rich Text Format 
(.rtf), and Plain Text (.txt). 

Pocket Word contains a list of the files stored on your device. 
Tap a file in the list to open it. To delete, make copies of, and 
send files, tap and hold a file in the list. Then, select the ap-
propriate action on the pop up menu. 



 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Select the folder type you want displayed in the list. 
Tap to change the sort order of the list. 
Tap to open a document. 
Tap and hold an item to see a pop-up menu of actions. 
Tap to create a new documents. 
 

You can change the zoom magnification by tapping View and 
then Zoom. Select a higher percentage to enter text and a lower 
one to see more of  your document. 
 

If you are opening a Word document created on a PC, select 
Wrap to Window on the View menu so that you can see the 
entire document. 
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You can enter information in Pocket Word in one of four modes 
(typing, writing, drawing, and recording), which are displayed 
on the View menu. Each mode has its own toolbar, which you 
can show and hide by tapping the Show/Hide Toolbar button on 
the command bar. 
a. Typing Mode 
Using the input panel, enter typed text into the document. For 
more information on entering typed text, see Chapter 2. 
To format or edit existing text, first select it by using your 
stylus to drag through the text. 
You can search a document for text by tapping Edit and then 
Find/Replace. 
b. Writing Mode 
In writing mode, use your stylus to write directly on the screen. 
Ruled lines are displayed as a guide, and the zoom magni-
fication is greater than in typing mode to allow you to write 
more easily. For more information on writing and selecting 
writing, see Chapter 2. 
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If you cross three ruled lines in a single stylus stroke, the writing 
becomes a drawing and can be edited and manipulated as 
described in the following section.  
Written words are converted to graphics (metafiles) when a 
Pocket Word document is converted to a Word document on your 
PC. 

c. Drawing Mode 
In drawing mode, use your stylus to draw on the screen. Gridlines 
appear as a guide. When you lift your stylus off the screen after 
the first stroke, you’ll see a drawing box indicating the boundaries 
of the drawing. Every subsequent stroke within or touching the 
drawing box becomes part of the drawing. For more information 
on drawing and selecting drawings, see Chapter 2. 
 

d. Recording Mode 
In recording mode, you can embed a recording into your 
document. Recordings are saved as .wav files. For more 
information on recording, see Making a Recording in Chapter 2. 
For more information on using Pocket Word, tap   and then 
Help. 

Pocket Excel works with Microsoft Excel on your PC to 
provide easy access to copies of your workbooks. You can 
create new workbooks on your device, or you can copy work-
books from your PC to your device. Synchronize workbooks 
between your PC and your device so that you have the most up-
to-date content in both locations. 
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Tap    
z Programs 
z Pocket Excel 
z and then New. A 
blank workbook appears.  

 If you have selected a template for new workbooks in the 
Options dialog box, that template appears with appropriate text 
and formatting already provided.  
 



 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Pocket Excel provides fundamental spreadsheet tools, such as 
formulas, functions, sorting, and filtering. To display the toolbar, 
tap View and then Toolbar.  
 

You can open only one workbook at a time; when you open a 
second workbook, you will be asked to save the first. You can save 
a workbook you create or edit in a variety of formats, including 
Pocket Excel (.pxl) and Excel (.xls). 
 

If your workbook contains sensitive information, you can protect it 
with a password. To do so, open the workbook; tap Edit, and then 
Password. Every time you open the workbook, you will need to 
enter the password, so choose one that is easy for you to remember 
but hard for others to guess. 
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Note the following when working in large worksheets in Pocket 
Excel: 
 

View in full screen mode to see as much of your worksheet as 
possible. Tap View and then Full Screen. To exit full screen mode, 
tap Restore 

Show and hide window elements. Tap View and then tap the 
elements you want to show or hide. 
 

Freeze panes on a worksheet. First select the cell where you want to 
freeze panes. Tap View and then Freeze Panes. You might want to 
freeze the top and leftmost panes in a worksheet to keep row and 
column labels visible as you scroll through a sheet. 
 

� Split panes to view different areas of a large worksheet. Tap View 
and then Split. Then drag the split bar to where you want it. To 
remove the split, tap View and then Remove Split. 
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Show and hide rows and columns. To hide a hidden row or 
column, select a cell in the row or column you want to hide. Then 
tap Format, then Row or Column, and then Hide. To show a 
hidden row or column, tap Tools, then Go To, and then type a 
reference that are in the hidden row or column. Then tap Format, 
then Row or Column, and then Unhide. 

Use Microsoft Windows Media Player for Pocket PC to play 
digital audio and video files that are stored on your device or on a 
network. To switch to Windows Media Player for Pocket PC, tap 

  
z Windows Media. 
Use Microsoft Windows Media Player on your PC to copy digital 
audio and video files to your Pocket PC. Your Pocket PC can play 
Windows Media and MP3 files. 
For more information about using Windows Media Player for 

Pocket PC, tap    
z and then tap Help. 

Use Microsoft Reader to read e-Books on your device.  Download 
books from your favorite e-Book web site to your PC, then use 
ActiveSync to copy the files to your activated device. To open a 
book, tap it's title in the MS Reader Library. 
 

To switch to Microsoft Reader, tap   
z  Programs, and then 
z  
Microsoft Reader. 
Page through the book by using the Up/Down control on your 
device or by tapping the page number on each page. 
Annotate the book with highlighting, bookmarks, notes, and 
drawings. 
Search for text and look up definitions for words. 
The Guide-book contains all the information you need to use the 
software. To open the Guide-book, tap Help 
Reader command bar. Or, on a book page, tap and hold on the 
book title, and then tap Help on the pop up menu. 
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You can purchase and download book files from the Web to your 
PC and then synchronize them with your Pocket PC. However, 
before you can do this, you must  

 Activated your device 
 Have an activated copy of MS Reader on your PC 
 Set up synchronization for Files in ActiveSync. 

 

1. Open ActiveSync on your PC 
z then check that you have 
selected synchronize Files. If you have done so it will 
appear under Information Type; if you have not, click 

Options, Sync options 
z tap Files and then OK from the 
pop-up menu. (The pop-up menu is telling your computer 
will create a folder in which you must put files you wish 
to synchronize) 

2. If you have not already activated your device, open your 
web browser, go to http://das.Microsoft.com/activate and 
follow the instructions. 

3. Go to www.microsoft.com/reader/shop.asp for a list of 
retailers selling MS Reader e-Books. 

4. If you do not have a copy of MS Reader on your PC, go to 
one of the retailers listed above and download a free copy 
from their site; then activate it as described above. 

5. Go to one of the MS Reader e-Book sites, and follow the 
instructions for choosing, purchasing and downloading a 
book to your desktop.  

6. Use Windows Explorer on your desktop to locate the MS 

Reader’s My Library folder 
z and the Pocket PC My 

Documents folder. Find the book title in My Library 
z 
and then copy it to Pocket                                                                                                                                                                                         
PC My Documents.  ActiveSync will then download the 
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The Library, your MS Reader home page, displays a list of all books 
stored on your device or storage card. 
a. To open the Library : 

Tap   
z Programs 
z Microsoft Reader.  
 On a book page, tap the book title, and then tap Library on the pop up 

menu. 
b. To open a book : 
Tap its title in the Library list. 
 

Each book consists of a cover page, an optional table of contents, and the 
pages of the book. Navigation options are listed in the bottom portion of 
the cover page.  
Subsequently, whenever you open the book, you� ll be automatically 
taken to the last page read. 
In addition to the text, each book page includes a page number and book 
title.  
Page through a book by using the Up/Down control on your device. 
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Reading a book electronically gives you several options not available 
with paper books. These options are available from any book page. 
 

Select text by dragging across the text on the page. Then, tap an option 
on the pop up menu, as described below: 

Search for Text. Find text in a book by tapping Find on the pop up menu. 
Enter the word you want to search for, and tap the desired Find option. 
Reader highlights found text on the page. To close Find, tap outside the 
box. To return to your original page, tap the title and then tap Return on 
the pop up menu. 
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Copy Text. You can copy text from books that support this feature into 
any program that accepts text. On a book page, select the text you want to 
copy. Then, tap Copy Text on the pop up menu. The text can be pasted 
into the program of your choice. 

Bookmarks. When you add a bookmark to a book, a color-coded 
bookmark icon appears in the right margin. You can add multiple 
bookmarks to a book. Then, from anywhere in the book, tap the 
bookmark icon to go to the bookmarked page. 
 
Highlights. When you highlight  text, it appears with a colored 
background.  
When you attach a note to text, you enter the text in a note pad that 
appears on top of the book page. A  Note icon will display in the left 
margin. To show or hide the note, tap the icon. 

Drawings. When you add a drawing, a Drawing icon appears in the 
bottom-left corner of the page, and drawing tools appear across the 
bottom of the page. Draw by dragging your stylus. 
 

To see a list of a book’s annotations, including bookmarks, highlights, 

text notes, and drawings, tap Go to 
z Annotations Index on the book’s 
cover page. You can tap an entry in the list to go to the annotated page. 

Removing a Book 
 

When you finish reading a book, you can delete it to conserve space on 
your device. If a copy of the book is stored on your PC, you can 
download it again at any time.  
To remove a book from your device, tap and hold the title in the Library 
list, and then tap Delete on the pop up menu. 

Pictures collects, organizes and sorts .jpg picture files on your device. 
You can download images to your PC, and then use ActiveSync to copy 
the files to your Pocket PC Phone.  After that, you can view the images 
as a slide show. 
 



 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Pictures can also be stored and transferred to your device from an MMC, 
SD or digital camera card. Insert a card into the memory card slot and 
then copy or drag the pictures from your PC to the My Documents 
directory on the memory card (If  the memory card does not have a My 
Documents directory you must create one first). 
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Pictures stored on your PC can be synchronized with Pictures on your 
device. Picture synchronization is not automatically selected in 
ActiveSync, you need to tap the sync option Files in ActiveSync on your 
desktop PC to activate this function. 
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Tap   
z Programs 
z Pictures. 
Tap My Pictures and select a folder from the drop-down menu. 
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In picture, tap   to view pictures as a slide show. 
 Tap    to view pictures stored in your My Picture folder. 
 Tap   to view pictures stored on a storage card. 

Tap anywhere on the screen to display the Slide show  toolbar, which you 
can use to pause the slide show, rotate the view, and more. 
Press the Left / Right controls to move forward or backward through the 
slides. 
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Tap   
z Programs 
z Pictures. 
Tap Name and select an option  from the drop-down menu. 
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Hold the stylus firmly on the file name of the picture you want to delete, 
and then select Delete from the pop up menu. 
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You can rotate, crop, zoom and adjust the brightness and color contrast of 
your .jpg pictures. 

 Tap   to rotate a picture 90 degrees counter-clockwise. 
 Tap   to crop a picture by dragging and selecting the crop area. Tap 

outside of the box to stop cropping. 
 Tap    to display the Zoom panel, from which you can zoom in or out 

of a picture, or return a picture to full-screen size. 

 Tap Edit 
z Brightness and Contrast to adjust the brightness and contrast 
levels of a picture.  

Tap Edit->Undo to undo an edit. 
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You can use one of  your own .jpg pictures as the background on the 
Today screen, and specify how you want it displayed on the screen, such 
as adjusting the transparency level. 

 In Pictures, tap the picture you want to set as the background. 

 Tap Tools 
z Set as Today Wallpaper. 
 

The default setting for the transparency level of the background picture is 
65%. To change the setting,  tap the option Set as Today Wallpaper. 
 

��#����/����"����
�#�
You can opt to launch the Pictures program automatically when a digital 
camera storage card is inserted and decide on a time delay length 
between slides when showing a slide show. 
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Tap   
z Programs 
z Pictures. 

Tap Tools 
z Options 
z then General. 
 Then check the box next to Detect digital camera storage cards. 
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Tap   
z Programs 
z Pictures. 

Tap Tools 
z Options 
z then Slide Show. 
Select a number of seconds then Tap OK. 


